MOS 2013 Study Guide

EXAM 77-420
Microsoft Excel
Contents

Introduction .............................................................................................................. vii
  Who this book is for ....................................................................................... vii
  How this book is organized ........................................................................ viii
  Download the practice files ........................................................................ viii
  Sidebar: Adapting exercise steps ................................................................... x
Ebook edition ........................................................................................................ xi
Get support and give feedback ....................................................................... xi
  Errata .............................................................................................................. xi
  We want to hear from you ............................................................................. xii
  Stay in touch ................................................................................................. xii
Taking a Microsoft Office Specialist exam ...................................................... xiii
  Microsoft Office Specialist certification ...................................................... xiii
  Selecting a certification path ........................................................................ xiii
  Test-taking tips ............................................................................................ xiv
  Certification benefits ................................................................................... xv
  For more information ..................................................................................... xvi

Exam 77-420  Microsoft Excel 2013
  Prerequisites ................................................................................................ 1
  Managing worksheets .................................................................................... 2
  Managing worksheet content ....................................................................... 2
  Managing Excel tables ................................................................................ 3
  Managing data entries ................................................................................ 3

What do you think of this book? We want to hear from you!
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit: microsoft.com/learning/booksurvey
1 Create and manage workbooks and worksheets

1.1 Create workbooks and worksheets ........................................................................... 6
   Creating new workbooks and worksheets ................................................................. 6
   Reusing existing content ............................................................................................ 7
   Practice tasks ............................................................................................................ 10

1.2 Navigate through worksheets and workbooks ....................................................... 10
   Locating data and worksheet elements ...................................................................... 10
   Inserting hyperlinks .................................................................................................. 13
   Practice tasks ............................................................................................................ 16

1.3 Format worksheets and workbooks ........................................................................ 16
   Modifying page setup ............................................................................................... 16
   Inserting page elements ........................................................................................... 18
   Changing workbook themes and colors ..................................................................... 21
   Modifying rows and columns .................................................................................. 23
   Configuring data validation ..................................................................................... 25
   Practice tasks ............................................................................................................ 28

1.4 Customize options and views for worksheets and workbooks ......................... 29
   Displaying different views of worksheets ................................................................... 29
   Displaying multiple parts of a workbook ................................................................... 30
   Hiding and displaying workbook content .................................................................. 33
   Customizing the Quick Access Toolbar ..................................................................... 35
   Customizing the ribbon ............................................................................................. 37
   Working with macros ................................................................................................. 39
   Modifying workbook properties ................................................................................ 41
   Practice tasks ............................................................................................................ 43

1.5 Configure worksheets and workbooks to print or save ..................................... 44
   Printing workbook content ....................................................................................... 44
   Saving workbooks ...................................................................................................... 46
   Practice tasks ............................................................................................................ 52

Objective review ........................................................................................................ 52

2 Manage cells and ranges

2.1 Insert data in cells and ranges .................................................................................. 54
   Creating data ............................................................................................................ 54
   Reusing data .............................................................................................................. 59
   Practice tasks ............................................................................................................ 63
2.2 Format cells and ranges ........................................... 64
  Formatting cell structure ........................................... 64
  Formatting cell content ........................................... 66
  Applying number formats ........................................... 69
  Copying formatting ........................................... 72
  Practice tasks ........................................... 73
2.3 Order and group cells and ranges .................................... 74
  Modeling data ........................................... 74
  Creating named ranges ........................................... 79
  Working with data groups and summaries ........................................... 81
  Practice tasks ........................................... 84
Objective review ........................................... 85

3 Manage tables 87
  3.1 Create tables ........................................... 88
  Practice tasks ........................................... 92
  3.2 Modify tables ........................................... 93
  Practice tasks ........................................... 95
  3.3 Filter and sort tables ........................................... 96
  Practice tasks ........................................... 99
Objective review ........................................... 100

4 Apply formulas and functions 101
  4.1 Utilize cell ranges and references in formulas and functions ........................................... 102
    Referencing cells and cell ranges in formulas ........................................... 102
    Defining order of operations ........................................... 105
    Practice tasks ........................................... 106
  4.2 Summarize data by using functions ........................................... 107
    Practice tasks ........................................... 112
  4.3 Utilize conditional logic in functions ........................................... 112
    Practice tasks ........................................... 115
  4.4 Format and modify text by using functions ........................................... 116
    Practice tasks ........................................... 120
Objective review ........................................... 120
5  Create charts and objects  121
   5.1  Create charts .......................................................... 122
        Practice tasks ...................................................... 127
   5.2  Format charts ............................................................ 127
        Practice tasks ...................................................... 131
   5.3  Insert and format objects ............................................ 132
        Adding pictures to sheets. ........................................ 132
        Adding text boxes to sheets ..................................... 134
        Adding SmartArt graphics to sheets .......................... 135
        Practice tasks ...................................................... 137
        Objective review .................................................... 138

Index ................................................................. 139

About the author ..................................................... 149

Survey page ............................................................ 150

What do you think of this book? We want to hear from you!

Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit: microsoft.com/learning/booksurvey
Introduction

The Microsoft Office Specialist (MOS) certification program has been designed to validate your knowledge of and ability to use programs in the Microsoft Office 2013 suite of programs, Microsoft Office 365, and Microsoft SharePoint. This book has been designed to guide you in studying the types of tasks you are likely to be required to demonstrate in Exam 77-420: Microsoft Excel 2013.

See Also  For information about the tasks you are likely to be required to demonstrate in Exams 77-427 and 77-428: Microsoft Excel 2013 Expert, see MOS 2013 Study Guide for Microsoft Excel Expert by Mark Dodge (Microsoft Press, 2013).

Who this book is for

MOS 2013 Study Guide for Microsoft Excel is designed for experienced computer users seeking Microsoft Office Specialist certification in Excel 2013.

MOS exams for individual programs are practical rather than theoretical. You must demonstrate that you can complete certain tasks or projects rather than simply answering questions about program features. The successful MOS certification candidate will have at least six months of experience using all aspects of the application on a regular basis; for example, using Excel at work or school to create and manage workbooks and worksheets, modify and format cell content, present data in tables and charts, perform calculations on data, and insert and format objects in a worksheet.

As a certification candidate, you probably have a lot of experience with the program you want to become certified in. Many of the procedures described in this book will be familiar to you; others might not be. Read through each study section and ensure that you are familiar with not only the procedures included in the section, but also the concepts and tools discussed in the review information. In some cases, graphics depict the tools you will use to perform procedures related to the skill set. Study the graphics and ensure that you are familiar with all the options available for each tool.
How this book is organized

The exam coverage is divided into chapters representing broad skill sets that correlate to the functional groups covered by the exam, and each chapter is divided into sections addressing groups of related skills that correlate to the exam objectives. Each section includes review information, generic procedures, and practice tasks you can complete on your own while studying. When necessary, we provide practice files you can use to work through the practice tasks. You can practice the procedures in this book by using the practice files supplied or by using your own files.

Throughout this book, you will find Strategy tips that present information about the scope of study that is necessary to ensure that you achieve mastery of a skill set and are successful in your certification effort.

Download the practice files

Before you can complete the practice tasks in this book, you need to download the book’s practice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/mosExcel2013/files

Important The Excel 2013 program is not available from this website. You should purchase and install that program before using this book.

If you would like to be able to refer to the completed versions of practice files at a later time, you can save the practice files that you modify while working through the exercises in this book. If you save your changes and later want to repeat the exercise, you can download the original practice files again. The following table lists the practice files for this book.

<table>
<thead>
<tr>
<th>Folder and chapter</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOSExcel2013\Objective1</td>
<td>Excel_1-1.xlsx</td>
</tr>
<tr>
<td>1 Create and manage workbooks and worksheets</td>
<td>Excel_1-2a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-2b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-3a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-3b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-3c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-3d.xlsx</td>
</tr>
<tr>
<td>Folder and chapter</td>
<td>Files</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------</td>
</tr>
<tr>
<td>MOSExcel2013\Objective1 (continued)</td>
<td>Excel_1-4a.xlsx</td>
</tr>
<tr>
<td>1 Create and manage workbooks and worksheets</td>
<td>Excel_1-4b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-4c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-5a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-5b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_1-5b.xlsx</td>
</tr>
<tr>
<td>MOSExcel2013\Objective2</td>
<td>Excel_2-1a.xlsx</td>
</tr>
<tr>
<td>2 Manage cells and ranges</td>
<td>Excel_2-1b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-1c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-1d.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-2a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-2b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-3a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-3b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-3c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-3d.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_2-3e.xlsx</td>
</tr>
<tr>
<td>MOSExcel2013\Objective3</td>
<td>Excel_3-1.xlsx</td>
</tr>
<tr>
<td>3 Manage tables</td>
<td>Excel_3-2.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_3-3a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_3-3b.xlsx</td>
</tr>
<tr>
<td>MOSExcel2013\Objective4</td>
<td>Excel_4-1a.xlsx</td>
</tr>
<tr>
<td>4 Apply formulas and functions</td>
<td>Excel_4-1b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_4-1c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_4-2a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_4-2b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_4-3.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_4-4.xlsx</td>
</tr>
<tr>
<td>MOSExcel2013\Objective5</td>
<td>Excel_5-1a.xlsx</td>
</tr>
<tr>
<td>5 Create charts and objects</td>
<td>Excel_5-1b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_5-1c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_5-2a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_5-2b.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_5-2c.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_5-3a.xlsx</td>
</tr>
<tr>
<td></td>
<td>Excel_5-3b.png</td>
</tr>
<tr>
<td></td>
<td>Excel_5-3c.txt</td>
</tr>
<tr>
<td></td>
<td>Excel_5-3d.jpg</td>
</tr>
</tbody>
</table>
Adapting exercise steps

The screen images shown in this book were captured at a screen resolution of 1024 × 768, at 100 percent magnification. If your settings are different, the ribbon on your screen might not look the same as the one shown in this book. For example, you might have more or fewer buttons in each of the groups, the buttons you have might be represented by larger or smaller icons than those shown, or the group might be represented by a button that you click to display the group’s commands. As a result, exercise instructions that involve the ribbon might require a little adaptation. Our instructions use this format:

➜ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list or on a menu, our instructions use this format:

➜ On the Home tab, in the Editing group, click the Find arrow and then, on the Find menu, click Advanced Find.

Tip On subsequent instances of instructions located on the same tab or in the same group, the instructions are simplified to reflect that we’ve already established the working location.

If differences between your display settings and ours cause a button to appear differently on your screen than it does in this book, you can easily adapt the steps to locate the command. First click the specified tab, and then locate the specified group. If a group has been collapsed into a group list or under a group button, click the list or button to display the group’s commands. If you can’t immediately identify the button you want, point to likely candidates to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you read and work through the exercises in this book.

In this book, we provide instructions based on the traditional keyboard and mouse input methods. If you’re using the program on a touch-enabled device, you might be giving commands by tapping with a stylus or your finger. If so, substitute a tapping action any time we instruct you to click a user interface element. Also note that when we tell you to enter information, you can do so by typing on a keyboard, tapping an on-screen keyboard, or even speaking aloud, depending on your computer setup and your personal preferences.
Get support and give feedback

The following sections provide information about getting help with this book and contacting us to provide feedback or report errors.

Errata

We’ve made every effort to ensure the accuracy of this book and its companion content. Any errors that have been reported since this book was published are listed on our Microsoft Press site:

http://aka.ms/mosExcel2013/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, send an email message to Microsoft Press Book Support at:

mspinput@microsoft.com

Please note that product support for Microsoft software is not offered through the preceding addresses.
We want to hear from you

At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance for your input!

Stay in touch

Let’s keep the conversation going! We’re on Twitter at:

http://twitter.com/MicrosoftPress
Taking a Microsoft Office Specialist exam

Desktop computing proficiency is increasingly important in today’s business world. When screening, hiring, and training employees, employers can feel reassured by relying on the objectivity and consistency of technology certification to ensure the competence of their workforce. As an employee or job seeker, you can use technology certification to prove that you already have the skills you need to succeed, saving current and future employers the time and expense of training you.

Microsoft Office Specialist certification

Microsoft Office Specialist certification is designed to assist employees in validating their skills with Office programs. The following certification paths are available:

- A Microsoft Office Specialist (MOS) is an individual who has demonstrated proficiency by passing a certification exam in one or more Office programs, including Microsoft Word, Excel, PowerPoint, Outlook, Access, OneNote, or SharePoint.
- A Microsoft Office Specialist Expert (MOS Expert) is an individual who has taken his or her knowledge of Office to the next level and has demonstrated by passing a certification exam that he or she has mastered the more advanced features of Word or Excel.

Selecting a certification path

When deciding which certifications you would like to pursue, you should assess the following:

- The program and program version(s) with which you are familiar
- The length of time you have used the program and how frequently you use it
- Whether you have had formal or informal training in the use of that program
- Whether you use most or all of the available program features
- Whether you are considered a go-to resource by business associates, friends, and family members who have difficulty with the program
Candidates for MOS-level certification are expected to successfully complete a wide range of standard business tasks, such as formatting a document or worksheet and its content; creating and formatting visual content; or working with SharePoint lists, libraries, Web Parts, and dashboards. Successful candidates generally have six or more months of experience with the specific Office program, including either formal, instructor-led training or self-study using MOS-approved books, guides, or interactive computer-based materials.

Candidates for MOS Expert–level certification are expected to successfully complete more complex tasks that involve using the advanced functionality of the program. Successful candidates generally have at least six months, and might have several years, of experience with the programs, including formal, instructor-led training or self-study using MOS-approved materials.

Test-taking tips

Every MOS certification exam is developed from a set of exam skill standards (referred to as the objective domain) that are derived from studies of how the Office programs are used in the workplace. Because these skill standards dictate the scope of each exam, they provide critical information about how to prepare for certification. This book follows the structure of the published exam objectives; see “How this book is organized” in the Introduction for more information.

The MOS certification exams are performance based and require you to complete business-related tasks or projects in the program for which you are seeking certification. For example, you might be presented with a file and told to do something specific with it, or presented with a sample document and told to create it by using resources provided for that purpose. Your score on the exam reflects how well you perform the requested tasks or complete the project within the allotted time.

Here is some helpful information about taking the exam:

- Keep track of the time. Your exam time does not officially begin until after you finish reading the instructions provided at the beginning of the exam. During the exam, the amount of time remaining is shown at the bottom of the exam interface. You can’t pause the exam after you start it.
- Pace yourself. At the beginning of the exam, you will receive information about the questions or projects that are included in the exam. Some questions will require that you complete more than one task. Each project will require that you complete multiple tasks. During the exam, the amount of time remaining to complete the questions or project, and the number of completed and remaining questions if applicable, is shown at the bottom of the exam interface.
- Read the exam instructions carefully before beginning. Follow all the instructions provided completely and accurately.

- Enter requested information as it appears in the instructions, but without duplicating the formatting unless you are specifically instructed to do so. For example, the text and values you are asked to enter might appear in the instructions in bold and underlined text, but you should enter the information without applying these formats.

- Close all dialog boxes before proceeding to the next exam question unless you are specifically instructed not to do so.

- Don’t close task panes before proceeding to the next exam question unless you are specifically instructed to do so.

- If you are asked to print a document, worksheet, chart, report, or slide, perform the task, but be aware that nothing will actually be printed.

- When performing tasks to complete a project-based exam, save your work frequently.

- Don’t worry about extra keystrokes or mouse clicks. Your work is scored based on its result, not on the method you use to achieve that result (unless a specific method is indicated in the instructions).

- If a computer problem occurs during the exam (for example, if the exam does not respond or the mouse no longer functions) or if a power outage occurs, contact a testing center administrator immediately. The administrator will restart the computer and return the exam to the point where the interruption occurred, with your score intact.

**Strategy**  This book includes special tips for effectively studying for the Microsoft Office Specialist exams in Strategy paragraphs such as this one.

### Certification benefits

At the conclusion of the exam, you will receive a score report, indicating whether you passed the exam. If your score meets or exceeds the passing standard (the minimum required score), you will be contacted by email by the Microsoft Certification Program team. The email message you receive will include your Microsoft Certification ID and links to online resources, including the Microsoft Certified Professional site. On this site, you can download or order a printed certificate, create a virtual business card, order an ID card, view and share your certification transcript, access the Logo Builder, and access other useful and interesting resources, including special offers from Microsoft and affiliated companies.
Depending on the level of certification you achieve, you will qualify to display one of three logos on your business card and other personal promotional materials. These logos attest to the fact that you are proficient in the applications or cross-application skills necessary to achieve the certification.

Microsoft Office Specialist
Microsoft Office Specialist Expert
Microsoft Office Specialist Master

Using the Logo Builder, you can create a personalized certification logo that includes the MOS logo and the specific programs in which you have achieved certification. If you achieve MOS certification in multiple programs, you can include multiple certifications in one logo.

For more information

To learn more about the Microsoft Office Specialist exams and related courseware, visit:

The skills tested in this section of the Microsoft Office Specialist exam for Microsoft Excel 2013 relate to creating tables. Specifically, the following objectives are associated with this set of skills:

3.1 Create tables
3.2 Modify tables
3.3 Filter and sort tables

Data stored in an Excel worksheet is organized in rows and columns of cells. Data in a contiguous range of cells is referred to as a data range. Similarly, an Excel table is a series of contiguous cells that have been formatted as a named Excel object that has functionality beyond that of a simple data range.

Some table functionality, such as the ability to sort and filter on columns, is also available for data ranges. Useful table functionality that is not available for data ranges includes the automatic application of formatting, the automatic copying of formulas, the ability to perform the following actions:

- Quickly insert column totals or other mathematical results
- Search for the named table object
- Expose the named table object in a web view
- Reference the table or any table field by name in a formula

This chapter guides you in studying methods for creating and modifying tables. It also covers how to filter and sort data that is stored in tables.

Practice Files To complete the practice tasks in this chapter, you need the practice files contained in the MOSExcel2013\Objective3 practice file folder. For more information, see “Download the practice files” in this book’s Introduction.
3.1 Create tables

The simplest way to create a table is by converting an existing data range. When you do so, you can retain the existing formatting or apply thematic formatting. You can also create a blank table and then add data to it. (Adding data to a table is often referred to as populating the table).

When you create a table, Excel evaluates the table content to identify the cells that are included in the table and define functional table elements (header rows and total rows) and formatting (emphasized columns and banding). Excel assigns a name to the table based on its order of creation in the workbook (Table1, Table2, and so on). You can change the table name to one that makes it more easily identifiable (such as 2014Sales, Students, or Products). When you assign the name, you can also identify the scope whether you want to reference the table by that name in the entire workbook or only in the current worksheet.

Inserting, deleting, or moving rows or columns in the table automatically updates the table formatting to gracefully include the new content. For example, adding a column to
the right end of a table extends the formatting to that column, and inserting a row in the middle of a table that has banded rows updates the banding. You can modify the table element selections at any time.

If you want to remove the table functionality from a table—for example, so you can work with the functionality that is available only for data ranges and not for tables—you can easily convert a table to text. Simply converting the table doesn’t remove any table formatting from the table. You can retain the formatting or clear it.

See Also For information about header rows, total rows, emphasized columns, and banding, see section 3.2, “Modify tables.” For information about functionality that is specific to data ranges, see Chapter 2, “Manage cells and ranges.”

➤ To convert a data range to an unformatted table
1. Click anywhere in the data range.
2. On the Insert tab, in the Tables group, click Table.
3. In the Create Table dialog box, do the following, and then click OK:
   - Verify that the correct data range is displayed in the dialog box (selected in the worksheet).
   - Verify that the My table includes headers check box is selected if the data range includes headers.

➤ To convert a data range to a formatted table
1. Click anywhere in the data range.
2. On the Home tab, in the Styles group, click Format as Table, and then click the formatting you want.
3. In the Format As Table dialog box, do the following, and then click OK:
   - Verify that the correct data range is displayed in the dialog box (selected in the worksheet).
   - Verify that the My table includes headers check box is selected if the data range includes headers.

➤ To change the name of a table
   ➔ Click any cell in the table. On the Design tool tab, in the Properties group, click the table name to select it, and then enter the name you want to assign to the table.

Or
1. Select the table by using one of the following methods:
   - At the left end of the formula bar, click the Name arrow, and then click the table name.
   - In the worksheet, drag to select all cells of the table.

2. In the Name box on the formula bar or in the Properties group on the Design tool tab, click the table name to select it. Then enter the name you want to assign to the table.

   Or

1. On the Formulas tab, in the Defined Names group, click Name Manager.
2. In the Name Manager window, click the table, and then click Edit.
3. In the Edit Name dialog box, select and replace the table name, and then click OK.

➤ To insert table rows and columns

   ➤ To add a column to the right end of a table, click in the cell to the right of the last header cell, enter a header for the new column, and then press Enter.

   ➤ To insert a single column within a table, click a cell to the left of which you want to add a column. On the Home tab, in the Cells group, click the Insert arrow, and then click Insert Table Columns to the Left.

   Or

   Select a table column to the left of which you want to insert a column, and then in the Cells group, click the Insert button.

   ➤ To add multiple columns within a table, select the number of columns that you want to insert, and then in the Cells group, click the Insert button.

   ➤ To add a row at the bottom of the table, click in any cell in the row below the last table row, enter the text for that table cell, and then press Tab.

   ➤ To add a row within the table, click a cell above which you want to add a row. On the Home tab, in the Cells group, click the Insert arrow, and then click Insert Table Rows Above.

   Or

   Select a table row above which you want to insert a column, and then in the Cells group, click the Insert button.

   ➤ To add multiple rows to a table, select the number of rows that you want to insert, and then in the Cells group, click the Insert button.
To move rows within a table

1. Select the table row or rows you want to move, and then do one of the following to cut the selection to the Microsoft Office Clipboard:
   - Press Ctrl+X.
   - Right-click the selection, and then click Cut.
   - Click Cut in the Clipboard group on the Home tab.

2. Select the table row above which you want to move the cut row or rows.

3. On the Home tab, in the Cells group, click the Insert arrow, and then click Insert Cut Cells.

Or

1. Select the worksheet row or rows containing the table row or rows you want to move, and then cut the selection to the Clipboard.

2. Select the worksheet row above which you want to move the cut row or rows.

3. On the Home tab, in the Cells group, click the Insert arrow, and then click Insert Cut Cells.

To move columns within a table

- Point to the top edge of the column you want to move. When the cursor changes to a four-headed arrow, drag the column to the new location (indicated by a thick vertical insertion bar).

Or

1. Select the worksheet column or columns containing the table column or columns you want to move, and then cut the selection to the Clipboard.

2. Select the worksheet column to the left of which you want to move the cut column or columns.

3. On the Home tab, in the Cells group, click the Insert arrow, and then click Insert Cut Cells.

To delete table rows and columns

- Select at least one cell in each row or column you want to delete. On the Home tab, in the Cells group, click the Delete arrow, and then click Delete Table Rows or Delete Table Columns.

- Right-click a cell in the row or column you want to delete, click Delete, and then click Table Columns or Table Rows.
To convert a table to a data range

- Right-click the table, click Table, and then click Convert to Range.
- Click anywhere in the table. Then on the Design tool tab, in the Tools group, click Convert to Range, and then in the Microsoft Excel dialog box, click Yes.

Practice tasks

The practice file for these tasks is located in the MOSExcel2013\Objective3 practice file folder. Save the results of the tasks in the same folder.

- Open the Excel_3-1 workbook, and complete the following tasks on the Sales worksheet:
  - Convert the data range A2:M23 to a table that includes a header row. (Retain the existing formatting.)
  - Assign the name Toys2013 to the table.
  - Move the July column so that it is between the June and August columns.
  - Move the Linda, Max, and Nancy rows at one time so that they are between the Kay and Olivia rows.
  - Add a row to the table for a salesperson named Raina, between the Quentin and Steve rows.
  - Add a row to the end of the table for a salesperson named William.
  - Add a column named December to the right end of the table.
3.2 Modify tables

When you create a table, you can apply a combination of formatting elements called a *table style*. The table style includes fonts, borders, and fills that are coordinated to provide a professional appearance. The available table styles are based on the worksheet theme colors. You can change the table style by choosing another from the Table Styles gallery.

**Tip** If you want to create the table and apply a specific table style at the same time, select the range containing the data, click Format As Table in the Styles group on the Home tab, and then click a style.
The table style governs the appearance of standard cells, special elements, and functional table elements, including the following:

- **Header row** These cells across the top of the table are formatted to contrast with the table content, require an entry, and look like column titles, but are also used to reference fields in formulas.

- **Total row** These cells across the bottom of the table are formatted to contrast with the table content. They do not require an entry, but clicking in any cell displays a list of functions for processing the numeric contents of the table column. These include Average, Count, Count Numbers, Max, Min, Sum, StdDev, and Var, and a link to the Insert Function dialog box from which any function can be inserted in the cell.

Table element formatting is designed to make table entries or fields easier to differentiate, and include an emphasized first column, emphasized last column, banded rows, and banded columns.

➤ **To apply a table style to a selected table**

1. On the Design tool tab, in the Table Styles group, click the More button (if your screen resolution allows for partial display of the Table Styles gallery), or click the Quick Styles button.

2. In the Table Styles gallery, click the style you want.
To modify functional table elements
- On the Design tool tab, in the Table Style Options group, select or clear the Header Row, Total Row, or Filter Button check boxes.

To apply contrasting formatting to specific table elements
- On the Design tool tab, in the Table Style Options group, select the Banded Rows, First Column, Last Column, or Banded Columns check box.

To clear formatting from a table
- Select any cell in the table. Then on the Design tool tab, on the Table Styles menu, click Clear.

To clear formatting from a data range
- Select the entire data range. On the Home tab, in the Editing group, click Clear, and then click Clear Formats.

Practice tasks
The practice file for these tasks is located in the MOSExcel2013\Objective3 practice file folder. Save the results of the tasks in the same folder.

- Open the Excel_3-2 workbook, and complete the following tasks on the Sales worksheet:
  - Change the table style to a Medium table style of your choice, and then apply banded rows.
  - Configure the table style options to emphasize the first and last columns of the table.
  - Add a total row to the table and change the row name to Average. Remove the total from the Year column. For each month, insert the average sales for that month in the row.

- On the Bonuses worksheet, remove the formatting from the ToyBonus table.
3.3 Filter and sort tables

You can easily sort and filter content in an Excel table by using the filter buttons located at the top of each column. If you prefer to hide the filter button, you can do so.

You can sort the values in one or more columns in a worksheet or table in either ascending or descending order. To sort on multiple columns, you specify in the Sort dialog box the order in which you want them to be sorted.

By default, Excel assumes that the first row in the worksheet contains column headings and does not include it in the sort. It also assumes that you want to sort by the values in the table cells. Standard sort orders are from A to Z for text, from smallest to largest for numbers, and from oldest to newest for dates. You can optionally sort by other features of the data range, including cell color, font color, and cell icon. These options are particularly useful in conjunction with conditional formatting.

You can also specify whether entries starting with uppercase and lowercase letters should be sorted separately and the orientation of the sort (whether you want to sort columns or rows).

**Tip** You can sort a table by the content of hidden columns within that table.

<table>
<thead>
<tr>
<th>Filtered rows</th>
<th>Active sort</th>
<th>Sort and filter options</th>
<th>Filter button</th>
<th>Active filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
</tr>
<tr>
<td>1</td>
<td>Product Name</td>
<td>Supplier</td>
<td>Category</td>
<td>Unit Price</td>
</tr>
<tr>
<td>2</td>
<td>3-gal watering can</td>
<td>Garr</td>
<td>Sort A to Z</td>
<td>$17.45</td>
</tr>
<tr>
<td>8</td>
<td>Bow rake</td>
<td>Garr</td>
<td>Sort Z to A</td>
<td>$21.50</td>
</tr>
<tr>
<td>9</td>
<td>Bow saw</td>
<td>Garr</td>
<td>Sort by Color</td>
<td>$7.50</td>
</tr>
<tr>
<td>15</td>
<td>Clay flowerpot 2&quot;</td>
<td>The</td>
<td>Clear Filter From &quot;Category&quot;</td>
<td>$3.05</td>
</tr>
<tr>
<td>16</td>
<td>Clay flowerpot 4&quot;</td>
<td>The</td>
<td>Filter by Color</td>
<td>$5.95</td>
</tr>
<tr>
<td>17</td>
<td>Clay flowerpot 6&quot;</td>
<td>The</td>
<td>Filter by Color</td>
<td>$1.75</td>
</tr>
<tr>
<td>18</td>
<td>Compost bin</td>
<td>Garr</td>
<td>Text Filters</td>
<td>Equals...</td>
</tr>
<tr>
<td>24</td>
<td>Edger</td>
<td>The</td>
<td>Does Not Equal...</td>
<td>$11.95</td>
</tr>
<tr>
<td>27</td>
<td>Fiberglass loppers</td>
<td>Garr</td>
<td>Begins With...</td>
<td>$18.25</td>
</tr>
<tr>
<td>30</td>
<td>Garden cart</td>
<td>Garr</td>
<td>Ends With...</td>
<td>$7.95</td>
</tr>
<tr>
<td>31</td>
<td>Garden fencing</td>
<td>Garr</td>
<td>Contains...</td>
<td>$10.95</td>
</tr>
<tr>
<td>32</td>
<td>Garden hoe</td>
<td>The</td>
<td>Does Not Contain...</td>
<td>$13.95</td>
</tr>
<tr>
<td>34</td>
<td>Gardening gloves (L)</td>
<td>The</td>
<td>Custom Filter...</td>
<td></td>
</tr>
</tbody>
</table>
You can sort a data range, but not a table, by rows rather than columns by selecting the Sort Left To Right option. This option is available only when the data range you’re sorting contains data that could be sorted in either direction. To successfully sort data from left to right, select a data range that includes only data, and not headers.

When simplifying a table that contains many entries, or when compiling data from multiple sources, you might find that a table contains multiple matching entries. You can easily remove duplicate data from a table by using the Remove Duplicates feature.

**Tip** Use conditional formatting to locate duplicates so you can review them before permanently deleting them by using the Remove Duplicates feature. If you are uncertain about deleting the duplicate data, copy the original data to another worksheet as a backup.
➤ To filter data in an Excel table

1. Click the filter button in the header of the column you want to filter.

2. At the top of the list of column entries, clear the (Select All) check box, and then select the check boxes of the items you want to display. Then click OK.

Tip You can enlarge the menu to display more options by dragging the handle in the lower-right corner of the menu.

➤ To remove a filter

➜ Click the filter button, and then click Clear Filter From Column.

➤ To sort a table by multiple columns

1. Click any cell in the range to be sorted. Then on the Home tab, in the Editing group, click the Sort & Filter button, and click Custom Sort.

   Or

   Click any cell in the range to be sorted, and then on the Data tab, in the Sort & Filter group, click the Sort button.

2. In the Sort dialog box, click the first column you want in the Sort by list. Then click the criteria by which you want to sort in the Sort on list. Finally, click the order you want in the Order list.

Tip The options in the Sort dialog box change if you click Cell Color, Font Color, or Cell Icon in the Sort On list.

3. Click Add Level, and repeat step 2 for the second column. Repeat this step for additional columns.

4. Click OK.
➤ **To sort a data range by rows**
   - In the Sort dialog box, click Options. In the Sort Option dialog box, click Sort left to right, and then click OK.

➤ **To remove duplicate rows from a table**
1. On the Data tab, in the Data Tools group, click Remove Duplicates.
2. In the Remove Duplicates dialog box, select the columns from which you want to remove duplicate entries. Then click OK.

   **Tip** Remove any outlines or subtotals from your data before trying to remove duplicates.

### Practice tasks

The practice files for these tasks are located in the MOSExcel2013\Objective3 practice file folder. Save the results of the tasks in the same folder.

- In the *Excel_3-3a* workbook, on the Bonuses worksheet, apply a filter to display only the bonuses that were less than $2,500.00.
- Open the *Excel_3-3b* workbook, and complete the following tasks on the Sales worksheet:
  - Sort the data in ascending order by category and by unit price.
  - Sort the data in descending order by category and alphabetically by name.
  - Remove duplicates so that there is only one entry for each supplier.
Objective review

Before finishing this chapter, ensure that you have mastered the following skills:

3.1 Create tables
3.2 Modify tables
3.3 Filter and sort tables
Symbols

& (ampersand) operator, concatenating with, 117
" " (quotation marks), in logical tests, 113

A

absolute references, 102, 104
addition
  order of operations and, 105
  SUM() function, 107, 109
  values in a data range that meet a condition, 114
alignment, specifying, 64
ampersand (&) operator, concatenating and, 117
anchoring graphics in headers and footers, 18
AND() function, 113
applying
  number formats, 69, 72
  styles to cells, 68
  themes to worksheets, 21
area charts, 122
arguments
  entering, 108
  LEFT() function, 116
  limit on amount per function, 108
  LOWER() function, 117
  MID() function, 116
  overview, 107
  RIGHT() function, 116
  TRIM() function, 117
  UPPER() function, 117
artistic effects, applying to pictures, 132
attributes, of fonts, 66
AutoFill series type, 55
automating data entry, 54
automation. See macros
AVERAGE() function
  purpose and syntax, 107
  results, displaying, 108
AVERAGEIF() function
  defined, 112
  entering formulas including, 115
  syntax, 113
averaging
  values in a data range, 110
  values in a data range that meet a condition, 115
B

background images, inserting, 18
bar charts, 122
binary workbooks (.xlsb), 47
blank workbooks, 7
browser view options for SharePoint sites, 50
bubble charts, 122

C

category axis, in charts, 127
cell ranges, 23, 104. See also conditional formatting
cell styles, 68
Cell Styles gallery, 67
cells
  adding to data ranges, 61
  configured with data validation, finding, 27
  copying formatting, 72
  deleting, 23
  entering content in, 3
  formatting, 64, 66
  height, 23, 64
  hidden, finding, 34
  merging, 66
  overview, 53
charts
  changing type of, 125, 130
  color scheme, changing, 131
  editing, 123, 125
  elements, 127, 130
  formatting, 127, 129, 131
  legends, 127
  moving, 129, 130
  overview, 121, 122
  plot area, 127
  recommended, 122
  resizing, 129
  selecting data, 124, 125
  shape styles, 131
  styles, 129, 130
  switching rows and columns, 126
  titles, 127
  types, 122
  clearing filters from tables, 98
  clearing print area, 45
color scales formatting rule, 74

color schemes
for charts, 131
for diagrams, 136

column charts, 122

columns
adjusting width, 24
aligning, 66
deleting, 23, 24
deleting from tables, 91
freezing, 30, 31
hiding, 33, 34
inserting, 23, 24
inserting in tables, 90
moving within tables, 91
resizing, 24
selecting, 2
sizing to fit contents, 25
sorting tables by, 96, 98
transposing with rows, 62
unfreezing, 32
unhiding, 33, 34
width, 25

comma delimited file format, 48

commands
Quick Access Toolbar, adding to, 35
removing from custom groups, 39

comparison, order of operations and, 105

Compatibility Mode, opening earlier versions of files in, 48

CONCATENATE() function
defined, 116
entering formulas including, 119
purpose and syntax, 117

concatenation
CONCATENATE() function and, 116, 119
order of operations and, 105

conditional formatting
applying, 77
cell fill, 77
color scales, 74, 77
custom, 75, 77
data bars, 74, 77
deleting, 78
font color, 77
highlight cells, 74, 77
icon sets, 74, 77
modifying, 78
overview, 74
rule types, 74
sorting and, 96
Stop If True option, 78
top/bottom, 74
conditional logic, 112, 113

counting cells
containing numeric values, 109
in data ranges that meet specific conditions, 114
non-empty, 110

COUNT() function
entering formulas including, 109
purpose and syntax, 107
results, displaying, 108

COUNTA() function
entering formulas including, 110
purpose and syntax, 107

COUNTIF() function
defined, 112
entering formulas including, 114
syntax, 113

COUNTIFS() function, 112
counting cells
containing numeric values, 109
in data ranges that meet specific conditions, 114
non-empty, 110

csv (comma delimited file format), 48

currency amounts, copying to adjacent cells, 58
custom
fill series, 55, 57, 58
formatting rules, 75, 77
number formats, 69, 70
themes, 22

customizing
options, 29
Quick Access Toolbar, 35
ribbon, 37
views, 29

D

data
copying to adjacent cells, 58
duplicates, removing, 97, 99
filtering, in tables, 96, 98
groups. See data groups
importing, 8
modeling, 74
outlining, 81
overview, 53
pasting over existing, 61
relationships, 5
replacing, 60, 62
reusing, 59
selecting for charts, 124, 125, 126
series, 54, 55
subsets, 82
subtotaling, 82, 83
summarizing, 82
data bars formatting rule, 74
data entry
  managing, 4
  restricting, 26
data groups
  displaying, 83
  hiding, 83
  levels, 81
  outlining, 83
  overview, 81
  ungrouping, 84
data labels, for charts, 127
data ranges
  defined, 53, 87
  adding cells to, 61
  averaging values, 110
  averaging values that meet a condition, 115
  clearing formatting from, 95
  converting to tables, 88, 89, 92
  counting cells that meet a condition, 114
  groups, designating as, 81
  highest value in, returning, 111
  lowest value in, returning, 111
  named ranges. See named ranges
  sorting by rows, 97, 99
  subtotaling, 82, 83
  summing values that meet a condition, 114
  vs. tables, 87
data series, 54, 55
data types, cell restrictions, 26
data validation
  canceling, 28
  error messages, 26, 27
  finding cells with, 27
  input messages, 27
  overview, 25
data date series type, 55
deleting
cells, 23
columns, 23, 24
conditional formatting, 78
custom number formats, 72
named ranges, 80, 81
rows, 23, 24
sparklines, 79
table rows and columns, 91
delimited formats
  tab, 48
  text, 7, 9
diagrams, 135, 136
displaying
  content in device-independent manner, 49
data groups, 83
formulas, 33
groups of columns and rows, 81
header and footer, 29
multiple parts of a workbook, 30
numbers, 3
properties, for workbooks, 41, 42
workbooks, in browsers, 50
worksheets, 29
division, order of operations and, 105
doughnut charts, 122
duplicate data, removing, 97, 99
E
email messages, hyperlinks to pre-addressed, 15
evaluating multiple conditions before returning a result, 113
exponentiation, order of operations and, 105
F
file formats
  defined, 48
  comma delimited, 48
  converting earlier versions of, 47
  fixed, 48
  .html, 48
  macro-enabled, 48
  .mht, 48
  .mhtml, 48
  PDF (Portable Document Format), 48
  saving workbooks in specific, 51
  Single File Web Page, 48
  tab delimited, 48
  template, 48
  text, 7, 9
  Web Page, 48
  .xls, 48
  .xlsx, 47
  .xlsx, 47
  .xlsx, 48
  XPS (XML Paper Specification), 48
  .xslx, 47
file names in references, 103
files, non-native, opening, 10
fill handle, 56

filling a series
advanced options, 57
AutoFill, 55
custom, 55, 57, 58
excluding formatting, 57
importing list from cells, 57
numeric, 57
series types, 54, 55
simple, 56

filtering tables, 96, 98
finding
cells configured with data validation, 27
data and worksheet elements, 10
formatting, 12
hidden cells, 34
highest or lowest value in a data range, 111
named elements, 12
specific properties, 13
text, 12
worksheet elements, 11

fonts
attributes, 66
conditional formatting, applying, 77
default, 66

footers, 18, 19, 20
Format Painter, 72

formatting
aligning columns, 64, 66
background images, 18, 20
cells, 64, 66
charts, 127, 129
clearing from data ranges, 95
clearing from tables, 95
columns, 23, 24
conditional, 74
copying, 72
data validation. See data validation
excluding when filling a series, 57, 58
fonts, 66, 77
headers and footers, 18, 19, 20
manually, 68
margins, 17
merging, 65
merging cells, 66
numbers, 69
page orientation, 17
paper size, 17
pictures, 132, 133
rotating headings, 64, 66
rows, 23, 24
rules. See formatting rules
searching for, 12
sparklines, 78
styles. See styles
tables, 88, 93, 94, 95
text, 134
text boxes, 134
text wrapping, 64, 66
themes, 21
watermarks, 18, 19, 20

formatting rules
applying, 77
cell fill, 77
color scales, 74, 77
custom, 75, 77
data bars, 74, 77
deleting, 78
font color, 77
highlight cells, 74, 77
icon sets, 74, 77
modifying, 78
overview, 74
Stop If True option, 78
top/bottom, 74
types, 74

formulas
default order of operations, 105
displaying, 33
named ranges in, 79
overview, 101
pasting results from one cell range to another, 61
references in, 102

freezing columns and rows, 30, 31
full-screen mode, 29

functional table elements, 94, 95
functions
arguments and, 107, 108
AVERAGE(), 107, 108, 110
AVERAGEIF(), 112, 113, 115
AVERAGEIFS(), 112
CONCATENATE(), 116, 119
COUNT(), 107, 109
COUNTA(), 107, 110
COUNTIF(), 112, 113, 114
COUNTIFS(), 112
formulas and, 107
LEFT(), 116, 118
LOWER(), 116
MAX(), 107, 111
MID(), 116, 118
MIN(), 107
nesting multiple, 113
overview, 107
RIGHT(), 116, 118
SUM(), 107, 109
SUMIF(), 113, 114
SUMIFS(), 112
TRIM(), 116, 119
UPPER(), 116, 119

fundamental tasks not covered in this book, 1
G
Go To command, 11
Go To Special command, 11, 13
graphics. See pictures
graphs. See charts
gridlines, hiding, 33, 34
grouping
data, 81, 83
worksheets, 22
groups, 39, 81
growth data series type, 54

H
headers
content, inserting into, 19
editing, 20
graphics, inserting into, 18
inserting, 20
overview, 18
properties, 18
headings, 33, 66
height
cells, 64
rows, 23, 24, 65
hidden cells, finding, 34
hiding
columns and rows, 34
data groups, 83
gridlines, 33, 34
headings, 33
workbook content, 33
worksheets, 33
highest value in a data range, finding, 111
highlight cells formatting rule, 74
嗪. html file format, 48
HTML Single File Web Page format, 48
hyerlinks, 13, 14, 15

I
icon sets formatting rule, 74
IF() function, 113
ignoring print area, 45
images. See pictures
importing
data in other formats, 7, 8
from text files, 9
inserting
charts, 125
columns, 23, 24
cut or copied cell contents, 23
diagrams, 135
graphic objects, 132
graphics in headers and footers, 18
hyperlinks, 14
objects, 6
rows, 23, 24
sparklines, 78
table rows and columns, 90
text boxes, 134
WordArt objects, 18
worksheets, 7
invalid range names, 80

L
landscape orientation, 17
layout. See page layout
LEFT() function
  defined, 116
  entering formulas including, 118
  syntax, 116
legends, for charts, 127
line charts, 122
linear data series type, 54
locating. See finding
logical tests, 112, 113
lowercase, converting text to, 116, 119
LOWER() function
  defined, 116
  entering formulas including, 119
  syntax, 117
lowest value in a data range, finding, 111

M
macro-enabled workbooks
  file formats, 47
  purpose, 48
macros
  modifying, 41
  overview, 39
  recording, 40
  saving, 40
margins, setting, 17
MAX() function
  entering formulas including, 111
  purpose and syntax, 107
merging cells, 65, 66
.mht file format, 48
.mhtml file format, 48
Microsoft Office Open XML Formats, 47
MID() function
- defined, 116
- entering formulas including, 118
- syntax, 116
MIN() function
- entering formulas including, 111
- purpose and syntax, 107
mixed references, 103
modeling data, 74
multiple-condition formulas, 112
multiplication, order of operations and, 105

N
Name Manager, 79, 80
named ranges
- creating, 79
- defining, 80
- deleting, 80, 81
- editing, 81
- in formulas, 79
- hyperlinks to, 15
- invalid, 80
- renaming, 81
- scope, 79
naming tables, 89
navigating. See hyperlinks; finding
negation, order of operations and, 105
nesting multiple functions, 113
non-empty cells, counting, 110
non-native files, opening in Excel, 10
NOT() function, 113
number formats
- custom, 69, 70, 72
- default, 3, 71
- overview, 69
numeric
- data, copying to adjacent cells, 58
- series, filling, 57
- values, adding, 109
- values, counting, 109

O
Office 365 SharePoint sites, adding to Save As locations, 50
order of operations, 105, 106
OR() function, 113
orientation
- rotating entries, 64
- setting, 17
outlining data groups, 81, 83

P
page breaks, previewing, 29
page layout
- headers and footers, 18, 20
- margins, 17
- orientation, 17
- overview, 16
- paper size, setting, 17
- scaling content to fit, 16
paper size, setting, 17
Paste Special, 59
pasting
- data, 59
- formula results, 61
- options, 58
- over existing data, 61
paths to other workbooks, 105
PDF (Portable Document Format), 48
percentages, order of operations and, 105
pictures
- background images, inserting in, 18
- changing shape of, 133
- copying, 133
- formatting, 133
- headers and footers, inserting in, 18
- inserting and formatting, 132
- moving, 133
- resizing, 133
- worksheets, inserting in, 132
pie charts, 122
plotting chart data. See charts
populating tables. See tables
Portable Document Format (PDF), 48
portrait orientation, 17
precedence, order of calculations, 105, 106
prerequisite skills and experience for this exam, 1
previewing page breaks, 29
print area, 44, 45
printing
- scaling content to fit page, 16, 44, 46
- settings for, 17
- workbooks, 44
- worksheets, 44, 45
properties for workbooks, 41, 42

Q
Quick Access Toolbar, 35, 36, 37
Quick Analysis tool, 122, 123
quotation marks (“ “), in logical tests, 113
R
radar charts, 122
ranges. See cell ranges; data ranges
readability of worksheets, 64
recording macros, 40
reference operators, order of operations and, 105
references
absolute, 102, 104
file names in, 103, 105
mixed, 103
ranges, to cells in, 103, 104
relative, 102, 104
types, 102
workbooks, to cells in other, 103
worksheets, to cells in other, 103, 104
relative references, 102, 104
removing duplicates from tables, 97
renaming worksheets, 2
replacing data, 60, 62
resetting interface to default, 39
resizing
all columns in a worksheet, 25
charts, 129, 130
columns, 24, 25
pictures, 133
rows, 24, 25
restricting data entry to specific options, 26
reusing data, 59
reusing worksheets from other workbooks, 7
ribbon, customizing, 37, 38
RIGHT() function
entering formulas including, 118
purpose and syntax, 116
rotating headings, 66
rows
adjusting height, 24
deleting, 23, 24
deleting from tables, 91
freezing, 30, 31
headings, hiding, 34
hiding, 33, 34
inserting, 23, 24
inserting in tables, 90
moving within tables, 91
resizing, 24
selecting, 2
sizing to fit contents, 25
sorting data ranges by, 97, 99
transposing with columns, 62
unfreezing, 32
unhiding, 34
ruler, 23

S
saving
See also file formats
earlier versions, for use in, 48
to remote locations, 49
to SharePoint sites, 50
in specific formats, 47, 51
workbooks, 46
scaling contents to fit, 16, 44, 46
scatter charts, 122
scope of named ranges, 79
searching. See finding
selecting
all content in worksheets, 2
chart data, 124, 125
columns, 2
data in tables, 3, 126
hyperlinks, 13
rows, 2
series
advanced options, 57
custom, 55, 57, 58
date, 55
filling. See filling a series
formatting, excluding, 57, 58
growth, 54
importing list elements from cells, 57
linear, 54
numeric, 57
simple, 56
shape styles
for charts, 131
for diagrams, 136
SharePoint, 50
sharing
files saved to remote locations, 49
files with users of Excel 2003 or earlier, 48
skills and experience, assumed for this exam, 1
SkyDrive
adding to Save As locations, 50
creating a folder, 46
SmartArt graphics, 135
sorting
conditional formatting and, 96
data ranges, by rows, 97, 99
standard sort order, 96
tables, by columns, 98
tables, overview, 96
spaces, removing from text, 116
sparklines
deleting, 79
formatting, 78
inserting, 78
sparklines (continued)
- overview, 76
- types, 76, 79

splitting windows, 30, 32

stock charts, 122

styles
- applying to cells, 68
- charts, 129, 130
- creating from formatted cells, 68
- defining new, 68
- diagrams, 136

subsets of data, 82

subtotaling, 82, 83

subtraction, order of operations and, 105

SUM() function
- entering formulas including, 109
- purpose and syntax, 107
- results, displaying, 108

SUMIF() function
- defined, 112
- entering formulas including, 114
- syntax, 113

SUMIFS() function, 112

summarizing data, 82, 83

surface charts, 122

syntax
- AVERAGEIF() function, 113
- CONCATENATE() function, 117
- COUNTIF() function, 113
- IF() function, 113
- LEFT() function, 116
- LOWER() function, 116
- MID() function, 116
- number formats, custom, 70
- RIGHT() function, 116
- SUMIF() function, 113
- TRIM() function, 117
- UPPER() function, 117

tab delimited file format, 48

table element formatting, 88, 94, 95

table styles, 93, 94

tables
- defined, 87
- clearing filters from, 98
- clearing formatting from, 95, 98
- columns, deleting, 91
- converting from data ranges, 89, 92
- converting to text, 89
- creating, 88
- vs. data ranges, 87
- deleting rows and columns, 91
- duplicates, removing, 97, 99
- formatting, 88, 93, 94
- functionality, 87
- inserting rows and columns, 90
- moving columns within, 91
- moving rows within, 91
- naming, 88, 89
- selecting data in, 3
- sorting by columns, 98

tabs
- adding custom groups to, 39
- adding custom to ribbon, 38
- changing color of worksheets, 22
- resetting to default, 39

templates
- creating new workbook from, 7
- file format, 48

text
- converting to lowercase with LOWER() function, 116, 119
- converting to uppercase with UPPER() function, 116
- copying to adjacent cells, 58
- file format, 48
- finding, 12
- removing spaces from with TRIM() function, 116, 119
- watermarks, 20
- wrapping, 64, 66

text boxes, 134

text files, importing from, 7, 9

themes, 21, 22

top/bottom formatting rule, 74

transposing rows and columns, 62

TRIM() function
- defined, 116
- entering formulas including, 119
- syntax, 117

unfreezing columns and rows, 32

ungrouping
- data, 84
- worksheets, 22

unhiding
- columns, 33, 34
- rows, 33, 34
- worksheets, 33

UPPER() function
- defined, 116
- entering formulas including, 119
- syntax, 117

uppercase, converting text to, 116, 119

URLs, inserting hyperlinks to, 14
V
validating data. See data validation
value axis, in charts, 127
variables. See arguments
views, of worksheets, 29

W
watermarks, 18, 20
Web Locations list, adding SharePoint sites to, 50
webpages, inserting hyperlinks to, 14
width of columns, adjusting, 24, 25
WordArt objects, inserting in worksheets, 18
workbooks
adding worksheets, 6, 7
creating blank, 7
creating from template, 7
default worksheets, 6
hyperlinks to, 15
opening earlier versions of files, 47
overview, 5
printing, 44
properties, 41, 42
references to cells in other, 104
saving, 46
saving in specific formats, 51
templates, saving as, 48
worksheets
adding to workbooks, 7
applying themes, 21
copying from other workbooks, 7
creating new, 7
defining print area, 44, 45
deleting, 2
grouping, 22
hiding, 33
hyperlinks to, 15
importing data, 7, 9
inserting objects, 6
named elements, finding in, 11
overview, 5
printing, 44, 45
readability, 64
references to cells in other, 104
renaming, 2
scaling content to fit page, 16, 44, 46
selecting all content, 2
tabs, changing color of, 22
ungrouping, 22
unhiding, 33
views, 29, 32
zoom level, 29, 30
wrapping text, 64, 66

X
x-axis, in charts, 127
.xls file format, 48
.xlsb file format, 47
.xlsm file format, 47, 48
.xlsx file format, 47
XML file format, 47
XPS (XML Paper Specification) document format, 48

Y
y-axis, in charts, 127

Z
zoom level, 29, 30